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  مقدمه

ابتدا علت استفاده از نرم افزار های شبیه ساز و مزایای ان را بیان می کنیم، سپس قدری راجع  مقالهدر این 

می  OPNETبا سایر شبیه سازها و علت انتخاب  آنتوضیح داده و به مقایسه  OPNET به نرم افزار 

 را ارائه می دهیم. آنپردازیم. در نهایت شبیه سازی و نتایج حاصل از 

و  آنالیزها را  ها رفتار شبکه آنامروزه با رشد چشمگیر شبکه های کامپیوتری روش هایی که بتوان توسط 

زمایش ایده های نوین خود نیاز آ بررسی کرد از اهمیت فراوانی برخوردارند . همچنین طراحان شبکه برای

طراحی  رای تدوین یک پروسههای گوناگون ب مند ابزارهایی جهت شبیه سازی رفتار شبکه ها هستند. شرکت

های  اند. در اکثر روال داده های هنگفتی انجام گذاری  برای رسیدن به عملکرد بهینه شبکه تلاش کرده و سرمایه

گیرد، یکی از  نیازها( و انجام طراحی انجام می وریآسازی شبکه که پس از فاز اول )جمع  طراحی، شبیه

ارهای شبیه ساز ابزار مناسبی برای شبیه سازی شبکه ها هستند. شود.نرم افز می مراحل مهم طراحی محسوب

 آنالیزهای امروزی که دارای ساختار با پیچیدگی بالا بوده و استفاده از روش های  به خصوص برای شبکه

 عملا به صورت دقیق امکان پذیر نیست. آنهاریاضی در بررسی رفتار 
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 شبکه و نرم افزارهای شبیه ساز

تقسیم بندی کرد. یکی از این دیدگاهها برای تقسیم  ساز های شبکه را از دید گاههای مختلف می توانشبیه 

است که برای شبیه سازی به کار می برند . به طوریکه در حالت کلی  بندی شبیه سازی های شبکه روشی

دقیق و روش دوم  آنالیزمتفاوت صورت می گیرد . روش اول شبیه سازی به کمک  شبیه سازی به دو روش

 حصول برای ریاضی های مدل از سازی شبیه برای اول روش در . است رویدادهای گسسته شبیه سازی

نتایج استفاده می شود و شبکه با مجموعه ای از معادلات ریاضی مدل می شود . عیب عمده این روش شبیه 

رشبیه سازی رفتار پویای شبکه سازی در ساده کردن بیش از حد شبکه در این مدل ها و عدم توانایی د

بسته های موجود در شبکه ( انجام شده و از  هاست . اما در روش دوم شبیه سازی در سطح پائین )در سطح

در این روش نتایج با شبیه سازی رویداد های گسسته به دست می  .این رو نتایج از دقت بالایی برخوردارند

با سرعت بالایی انجام می شود ، در این شبیه سازها نتایج با  اول که شبیه سازی ایند . اما بر خلاف روش

با  کمی حاصل خواهند شد . اما راه حل مناسب ، استفاده از ترکیب این دو روش در شبیه سازی سرعت

 .هدف داشتن عملکرد مورد قبول و حفظ دقت مورد نیاز در موارد بحرانی است

ترین شبیه سازهامی توان مهم از. گویند ب یا دو رگهشبیه سازها را اصطلاحا شبیه سازهای مرک این

 .کرد اشاره   NS-2 و OPNETبه

 OPNET معرفی شبیه ساز

OPNET دانشگاه در که MIT ارائه شد، این امکان را برای کاربر فراهم می کند تا به  1831و در سال

بپردازد. های مخابراتی مختلف ، ادوات شبکه ، و پروتکل های موجود در شبکه  طراحی و مطالعه شبکه

OPNET پروتکل های رایج در شبکه و مدل های مختلف سازی  شبیه برای که بوده تجاری ساز شبیه یک

به طوریکه در این نرم افزار مدل هایی برای شبیه سازی رود.  در شبکه های با رنج بسیار متنوع به کار می

ساده تا شبکه های ماهواره ای بزرگ وجود دارد . در  LAN گرفته و در حد یک شبکه هایی از ابعاد کوچک

عملکرد و رفتار شبکه ها استفاده میشود . این  آنالیزاین نرم افزار از شبیه سازی رویداد های گسسته جهت 

برای اجرای شبیه سازی  ینقابل نصب است . همچن Solaris  و Windows نرم افزار بر روی سیستم های

 شامل افزارکه نرم این کامل ازنصب پس. باشد شده نصب شما سیستم روی  ANSI یا  ++Cباید کامپایلر

 و Model Libraryهای قسمت
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 Modeler Documentation   و اجرای اولیه ی  نحوه نصب با جزئیات ارائه شده است(انتها است )در

 کرد. آغاز  OPNET با را کار توان می ، افزار نرم License به ن جهت وارد کردن اطلاعات مربوطآ

OPNET در مقایسه با سایر شبیه سازها 

 نیاز به خریدلایسنس دارد که بسیار گران است. واسط گرافیکی  OPNETمی باشد، open source که NS-2 ر خلافب

OPNET  با زبانشنایی آبسیار ساده و جذاب است وبرای برنامه نویسی نیاز بهC , C++ دارد. گفته میشود این اولین نرم 

بودن طرفداران بیشتری پیدا کرد. اما  open source به دلیل NS-2 اما مدتیآمد افزاریست که برای شبیه سازی شبکه به بازار

موبایل در شبیه سازی شبکه های بی سیم و  OPNET در سالهای اخیر به دلیل رونق شبکه های بی سیم وکارایی بی نظیر

بسیاری از وظایف را به صورت اتوماتیک انجام می  OPNET   ضمن اینکه .در صدر قرار گرفت OPNET )متحرک( دوباره

  .نیاز به برنامه نویسی هر چیز کوچکی از پایین ترین سطح نیست دهد و

روز وقت برای اجرا داشته  یکشاید نیاز به  NS-2 در ، سرعت اجرای بسیار بالاست. برنامه ای که OPNETاز دیگر مزایای 

بهتر  MATLABاز  از لحاظ سرعت هنوز نمی تواند OPNET سازی میشود. البته  در عرض چند ثانیه شبیه OPNETباشد در 

در  جهت مدلسازی MATLAB و استفاده از برنامه های  MATLAB این نرم افزار قابلیت ارتباط با عمل کند. همچنین

 .پروسس( را داردپایینترین سطح )سطح 

 OPNET مزایای

OPNET نآ نام از که همانطور  (Optimum Network Performance )، ی نرم افزار  مشخص است

های  سازی جنبه افزار در شبیه های این نرم . قابلیت سازد است که دستیابی به عملکرد بهینه را ممکن می

حیرت انگیز است. این نرم افزار به طراحان و  ، فیزیکیهای  مختلف شبکه، از لایه کاربرد گرفته تا لایه

 بینی کنند سازی پیش ها وتجهیزات را با دقت قابل قبولی از طریق شبیه دهد عملکرد پروتکل محققان اجازه می

 عرصه تاز یکه OPNET ، ما را متقاعد کرده است که NS – 2 های رقیب مانندنرم افزار . تجربه کار با 

 شبکه است.سازی  شبیه

 OPNET شنا آهای این نرم افزار به خوبی  است ، ولی تنها برای کاربرانی که باقابلیت  نرم افزاری قوی

دهد. البته به صورت کلی  افزار را بیش از حد پیچیده جلوه می های زیاد، این نرم باشند. متأسفانه قابلیت

 گردد. رو است که مزید بر علت می های خاصی رو به کامپیوتری با دشواری های سازی شبکه شبیه

 :عبارتند از   OPNETهای این نرم افزار واقعاً پایان ناپذیر است. کاربردهای مهم قابلیت
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های  تواند فایل : این نرم افزارمستقیماً می سازی های فعلی از طریق شبیه شبکه آنالیز .1

 سناریوی و کرده دریافت ورودی عنوان به را سیسکو مانند مختلف سازندگان روترهای تنظیمات

  .کند سازی شبیه را شبکه فعلی

های  کرد تا از هزینه ها را به صورت بهینه انتخاب توان لینک : با این نرم افزار می طراحی بهینه شبکه .2

 اضافی جلوگیری شود.

. ایجاد این اند مدهآهای تحقیقاتی به وجود  که در محیط دیدجهای  سازی عملکرد پروتکل شبیه .3

  .باشد می  FSMو ماشین حالت متنهای  ++C نویسی برنامه ها بر اساس پروتکل

 بزرگ این نرم افزار که شامل انواع روترها، سوییچ و سایر تجهیزات سازندگان بزرگی  با توجه به کتابخانه

ازویرایشگرهای و غیره است، جز در مواردی محدود نیازی به استفاده   Com ، Juniper 3مانند سیسکو، 

توان شبکه را  شود می نامیده می گره و پروسه نیست و تنها از طریق ویرایشگر اصلی که ویرایشگر شبکه

 صورت نمودارهای مختلف مشاهده نمود. ن را بهآسازی عملکرد  سازی کرد و نتایج شبیه پیاده

 OPNET  سازی را علاوه بر نمایش  نتایج شبیه تواند این نرم افزار می .است کارآمددر ارائه نتایج نیز بسیار

 متعدد، به صورت صفحه وب نیز ارائه کند. های به صورت گراف

ها شبکه فعلی در نرم  های تنظیمات روترها و سوییچ وارد کردن فایل امکان OPNETقابلیت بسیار جالب

های  این فناوریها در شبکهاند.  گسترش فراوانی یافته دنیااخیر در  دههسیم در  های بی فناوری . افزار است

های  ها، شرکت ISP مورد استفاده  های نقطه به چند نقطه های نقطه به نقطه و لینک سیم، لینک محلی بی

ها  سازی این شبکه توان برای شبیه مختلفی را می گیرند. نرم افزارهای های دولتی قرار می تجاری و شرکت

ها  سازی و اعمال ترافیک لایه افزارها یا توانایی شبیهنرم  استفاده کرد. با این وجود بیشتر این

هاو   نتنآها، پرتوی  سازی تأثیر مدولاسیون های لازم برای شبیه راندارند و یا از قابلیت (TCP/IP)بالاتر

 محیط انتقال برخوردار نیستند.

 :OPNETاز دیگر ویژگیهای شگفت انگیز 

نتن گیرنده یا آمثال برای قرار دادن  فاع،به عنواندارای یک محیط سه بعدی با قابلیت تنظیم ارت .1

 فرستنده در ارتفاع

 مراتبی)در سه دسته( برای راحتی و سرعت طراحی امکان طراحی سلسله .2
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 بیشتر با دنیای واقعی امکان تنظیم شرایط محیطی مانند دما، رطوبت و ... برای مطابقت هر چه .3

 برای برخی گره ها تعیین موبیلیتی، سرعت و جهت حرکت و ... امکان .4

 روز گروه پشتیبانی بسیار قوی و پرسرعت در تمام ساعات شبانه .3

 

  OPNET  های زیادی در  مذکور در بالا( ،قابلیت 2با استفاده از مدل سلسله مراتبی خود )ویژگی شماره

 ها عبارتند از : قابلیت گذارد. برخی از این سیم به نمایش می های بی سازی فناوری شبیه

 

 خطا. -انرژی های مختلف از طریق نمودار سازی مدولاسیون  شبیه .1

 نتنآسازی پرتوی   شبیه .2

 سازی توان ارسالی  شبیه .3

 ها Pipe Line  های انتشار از طریق  سازی محیط شبیه  .4

 Wi-Fiو UMTS،GPRSهای فناوری سازی  شبیه .3

پروتکل های و مدل های ارائه شده در زمینه شبکه  آخرینشبیه ساز بسیار کامل بوده و شامل  کتابخانه  این

است . همچنین این قابلیت را داراست که پژوهشگران شبکه برای خود اقدام به روزرسانی مدل های موجود 

 .ن کنندآدر 

در مقایسه با سایر شبیه سازها دارد از این رو ما OPNETبا توجه به مزایا و ویژگی های بسیاری که 

 . را برای شبیه سازی انتخاب کردیماین نرم افزار 

 OPNET اجزای نرم افزار

 به صورت یک ساختار شامل موارد زیر است:OPNETاجزای اصلی 

 Network Model Editor 

 Node Model Editor 

 Process Model Editor 

 این امکان را فراهم می سازد که مدل شبکه را با ماژول شبکه ایجاد کنیم در هرOPNET شبیه ساز 

مدل شبکه نودهای مورد نظر را با ماژول نود طراحی نماییم و رفتار هر گره را با ماژول پروسس 

با ماژول پروسس رفتار گره های مورد نیاز را تعریف کرده و سپس با ماژول  ابتدا .  تعریف کنیم
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در  . را به پروسس تعریف شده پیوند می زنیم آنهاگره ، گره های شبکه را طراحی کرده وسپس 

 شکل زیر ساختار ارتباطی بین ماژول های ذکر شده به خوبی قابل مشاهده است:

 

 ماژولها بین ارتباطی ساختار

 شبکه ماژول  ·

هنگامی که در ابتدا یک پروژه را ایجاد می کنیم پنجره پروژه تمام ابزارهای ماژول شبکه را برای 

ین امکان را می دهد که ابتدا یک ا کاربر به ابزارها این. میدهد قرار کاربر اختیار در  مدلسازی شبکه

( را انتخاب کند و بر اساس این WLANبا ابعاد سازمانی و یا یک شبکه   LANسناریو ) مانند شبکه 

سناریو ابزارهای و قطعات مناسب را در اختیار گرفته و طبق توپولوژی مورد نظر مدل شبکه را پیاده 

یابد. گره ها می توانند  ها ، لینک های ارتباطی و زیرشبکه ها تشکیل می سازی نماید. مدل شبکه از گره

هر قطعه از شبکه مانند سرور، ایستگاه سیار همراه، روترها و غیره باشند. اما زیر شبکه ها می توانند 

در دانشکده می تواند شامل اتاق هایی WLANبرای گروه بندی استفاده گردند برای نمونه یک شبکه 

ه هر اتاق با یک زیرشبکه مدلسازی شده است و در هر اتاق چندین کامپیوتر سیار بی سیم باشد ک

موجود است. لینک ها امکان اتصال بین گره ها را فراهم می سازند برای مثال یک لینک اترنت چندین 

 کامپیوتر را به یکدیگر متصل می گرداند.
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 مثالی از ماژول شبکه 

 

 

 گره ماژول  ·

،  (source)منبع (queue) شامل مولفه های عملکردی شبکه میشود بعنوان مثال صف مدل هرنود

 این مولفه ها می باشند.  ازجمله  (application)کاربردی برنامه و  (processor)ردازشگرپ

تواند  شامل مولفه های مختلف شبکه می همانطور که در شکل زیر مشاهده می شود مدل یک کلاینت

 ورد.آدر اجزای یک گره را به تصویر
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 گره ماژول از مثالی

 

 پروسس ماژول  ·

ماژول پروسس این امکان را به کاربر می دهد که رفتار یک گره را مدلسازی نماید این مدلسازی از 

و توابع C، بلوکهای برنامه به زبان state transition diagramطریق نمودار حالت های گذر 

 .میگردد سازی پیاده OPNETنرم افزار  Built-inتوکار

و  Finite State Machine (FSM)یک مدل پروسس می تواند شامل دیاگرام های حالت گذر یا 

 ورود هنگام به تواند می حالت هر. باشد موقتی یا و  و نیز متغیرهای حالتCماژولهای برنامه به زبان 

 دو به تواند می حالت یک این بر علاوه کند اجرا را برنامه کد مجموعه یک نآ از خروج یا و  نآ به

به هنگام ورود به حالت، کد اجرایی مربوط به ورود Forced به موسوم نآ نوع یک نماید رفتار شکل

را اجرا می کند و بدون درنگ به منظورخروج از حالت، کد اجرائی مربوط به خروج را اجرا می کند و 

حالت بعد را بررسی می کند در صورت درست بودن شرط به حالت بعدی می شرایط خروج و گذر به 

عمل نماید به این معنا که پس از اجرای کد Unforced شکل به میتواند حالت یک  رود. در مقابل
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ن حالت در انتظار یک سیگنال آن حالت، کنترل را به هسته برنامه انتقال داده و در آمربوط به ورود 

 ند با دریافت وقفه میتواند کد خروج را اجرا نماید.وقفه باقی می ما

 

 مثالی از ماژول پروسس
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 نحوه کار با نرم افزار

ر نماییم را ایجاد می کنیم در این مدل نوع شبکه، کا نآ روی بر خواهیم می که ایی شبکه مدل ابتدا

را در پنجره  شبکه ایدر زیرمدل .ن و اجزاء تشکیل دهنده شبکه را تعریف می کنیمآتوپولوژی 

Projectتوجه کنید که در این مرحله هر سه ماژول مذکور بکار گرفته می شود.مشاهدهمی کنیم. 

 

 بی سیم LANمثالی از شبکه 

 و تحلیل سازی، شبیه توسط که را( مشاهده تحت متغیرهای)  ماریآ های مشخصه شبکه، مدل ایجاد از پس

 های بسته نرخ سیستم، گذردهی تاخیر، مانند متغیرهایی جمله از کنیم می تعیین راآمد خواهند در نمایش به

 Choose"راست کلیک در پنجره حاوی مدل شبکه گزینه  منوی از منظور این برای. غیره و خطا

Individual Statistics"  را انتخاب می کنیم. همانطور که در زیر مشاهده می شود در کادرChoose 

Results  نظر را می توانیم معین کنیم.متغیرهای مورد 
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 ماریآ مشخصات تعیین

 روی بر کافیست منظور این برای میرسانیم انجام به ساز شبیه اجرای با را شبکه مدل تحلیل مرحله این در

کلیک نمائیم این گزینه همانطور که در شکل مشاهده Configure Discrete Event Simulation گزینه

 قرار دارد.Simulationمی شود در منوی 

 

 هشبک سازی شبیه تنظیمات

 

 تغییرات مشاهده معنای به تحلیل میباشد حاصل نتائج تحلیل و مشاهده ، شبکه سازی شبیه در مرحله آخرین
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تغییر پارامترهای مختلف شبکه میباشد. برای مثال تغییرات گذردهی  اثر در اماری های مشخصه در حاصل

 شبکه به هنگام تغییر در بار ترافیک شبکه.

 
شبکه سازی شبیه نتایج  
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 پیاده سازی یک شبکه داخلی کوچک

 معرفی

یک شبکه را ایجاد و شبیه سازی میکند  OPNET Modelerکه چگونه   در این مثال شما خواهید دید

فوکوس کرده و  Project Editorعملیات سنجش آن را انجام می دهد . این مثال بر روی نحوه استفاده از 

چگونگی استفاده با نود و پروسس را آموزش خواهد داد . همچنین در این مثال بر روی موارد زیر را می 

  آزمائیم   

  یک شبکهیع سر طراحی و پیاده سازی  

  عملکرد شبکه مورد در آمارجمع آوری 

 این آمار تحلیل و تجزیه 

برای ساخت یک توپولوژی جهت یک شبکه داخلی کوچک بهره برده   Project Editorدر این مثال ، از 

 جمع آوری میشود . نتایج و تجزیه و تحلیل شبیه سازی و اطلاعات آماری جهت اجرای

، در حال حاضر .برنامه ریزی  می کنید  را یک شرکت کوچک اینترانت گسترشدر این مثال ، شما عملیات 

برای  خود را برنامه های و ساختمان اداری طبقه اولدر  یک شبکه با توپولوژی ستارهاین شرکت دارای 

ا این سناریو را تا جایی شم  .باشید می طبقات در یکی دیگر از یک شبکه با توپولوژی ستاره  اضافه کردن

 که شبکه دوم  منجر به خطا در شبکه اول نشود ادامه خواهید داد . 
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 شبکه نهایی بصورت زیر خواهد بود

 

 

 پیاده سازی

یک  .ایجاد کنید جدید scenarioو    project باید برای بار اول شما، شبکه جدید مدل هنگام ایجاددر 

 پروژه ها  .است شبکه جنبه های مختلف مرتبط که هر کدام  تشریح کننده سناریوهای از یک گروه پروژه

 .باشد متعدد سناریوهای توانند می

میتوانید سناریو جدید را ایجاد کنید.  Wizard شما با استفاده از یک می کنید، یک پروژه جدیدپس از ایجاد 

 به شما اجازه میدهد  Wizardگزینه ای زیر در این 
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 از شبکه اولیه توپولوژی تعریف 

  شبکه اندازه مقیاس و تعریف 

  برای شبکه زمینه پس نقشه انتخاب 

  تعریف و انتخابobject palette  جهت استفاده در پروژه 

 در اختیار شما قرار میگیرد . New Projectاین ویزارد به ازای هر بار اجرای دستور 

 :زیر را انجام دهیدمراحل  سناریوی جدید جهت ایجاد یک Setup Wizard استفاده ازبرای 

 را انتخاب نمائید Newگزینه   Fileاز منوی   Opnet Modelerدر صفحه اصلی  .1

 را می فشاریم OKرا از منوی انتخاب و دکمه  Projectگزینه  .2

 پروژه و سناریو را مطابق با الگوی زیر نام گذاری کنید .3

  نام پروژه<initials>_Sm_Int  کهInitials   کلمه ای است که جهت عدم

 تکراری بودن نام فایل بکار میرود

  نام سناریو که آن راFirst_floor قرار دهید 

   Wizard .باز می شود 

 مقادیر زیر را به عنوان پارامتر انتخاب کنید  Wizardدر  .4

  
Dialog Box Name  Value  

1. Initial Topology  Select the default value: Create empty scenario.  

2. Choose Network Scale  Select Office. Select the Use metric units 

checkbox.  

3. Specify Size  Select the default size: 111 m x 111 m  

4. Select Technologies  Include the Sm_Int_Model_List model family.  

5. Review  Check values, then click Finish.  
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محیط کاری با اندازه انتخابی شما نمایان میشود . پالت اشیا که شما انتخاب نمودید در پنجره جداگانه باز 

 . میشود

 ایجاد شبکه

 ایجاد میگردد Project Editorمدل شبکه توسط تودها و لینکها از پالت اشیا در 

Node : نمایانگر یک شیء واقعی که توانایی ارسال و دریافت داده را دارد 

 

 نودها

Link   : بستر ارتباطی که نودها را به هم متصل میکند . لینکها نمایانگر اتصالات فیزیکی هستند )الکتریکی

 یا کابلهای نوری(

 

 لینک

 بصورت گرافیکی در دسترس قرار دارنددر پالت اشیا قرار دارند . در این پالت کلیه  اشیا  ابزارها این

 به یکی از سه روش زیر ویا بصورت ترکیبی میتوان یک توپولوژی شبکه ایجاد کرد  . 

 روش فراخوانی توپولوژی .1

 روش چیدن اشیا از پالت اشیا در صفحه کاری .2

 Rapid Configurationروش استفاده از  .3
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Rapid Configuration گره های انواع، تنظیمات شبکه از انتخاب پس در یک مرحله یک شبکهیجاد ا 

 .گره بکار میرود اتصال برای لینک هایی که و انواع درون شبکه،

 استفاده کنید Rapid Configurationبرای ایجاد شبکه طبقه اول از متد 

 برای ایجاد توسط این روش مطابق مراحل زیر اقدام کنید

 را انتخاب نمائید Topology > Rapid Configurationاز منوی  .1

 را بفشارید  Nextرا انتخاب نموده و  Starاز منوی کرکره ای کوچک نوع  .2

 

 

  3C_SSII_1111_3311_4s_ae32_e43_ge3را به  Center Node Modelمقدار  .3

 تغییر دهید

تغییر داده و تعداد را نیز به  Sm_Int_wkstnرا به   Periphery Node Modelگزینه  .4

 تغییر دهید 31

 تغییر دهید 11BaseTرا به   Link Modelنه گزی .3

 قرار گیری شبکه را انتخاب نمائید Yو  Xمختصات  .5

 تغییر دهید 21شعاع شبکه را به  .1

3. OK را بفشارید 
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 ترسیم میشود Project Editorشبکه در 
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 نمائیمحالا نیاز به ایجاد یک سرور داریم که از پالت اشیا آنرا توسط موس به محیط کار اضافه می 

 اگر پالت شبکه بسته شده است توسط این آیکون آنرا فراخوانی کنید .1

 

 را پیدا کنیدو آنرا به وسط صفحه کار بکشید Sm_Int_serverشیء  .2

 برای اتصال سرور به شبکه مطابق روال زیر اقدام کنید

 را از پالت اشیاء پیدا کرده و بروی آن دابل کلیک کنید 11BaseTشیء  .1

 بروی سرور فشرده و پس از آن نقطه انتهایی کابل را به سوئیچ متصل نمائیدموس را ابتدا  .2

3. Right click  نمائید تا انتخاب کابل غیر فعال گردد 

در انتها باید اشیاء را پیکربندی نمائید تا ترافیک نرم افزارها که بروی شبکه موجود هست را مشخص نمائید 

. پیکربندی و تنظیم مشخصات دستگاهها کار پیچیده ای است که در این مثال از آن صرف نظر می نمائیم . 

ون پالت اشیا استفاده میکنیم که شامل یک پروفایل آماده و یک پیکربندی آماده از دربرای این منظور ما از 

 آیتم های زیر است

  یک شی نرم افزاری با تعریف و توزیع و پیکربندی استاندارد 

 یک دیتا بیس 

 برای این منظور مطابق روال زیر اشیاء مورد نظر را بروی صفحه کار بکشید

 را یافته و بروی صفحه کار بکشید. Sm_Application_Configشیء  .1

2. Right Click 

 را یافته و بروی صفحه کار بکشید .  Sm_Profile_Configشیء  .3

4. Right Click 

 حال شبکه ما می بایست مطابق شکل زیر باشد
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 شکل نهایی شبکه ما

 حالا میتوانید به جمع آوری داده بپردازید

 هرچند قبل ازآن نگاهی خواهیم داشت به ویرایشگر نود و پروسس

هستند .. ویرایشگر نود جهت  OPNET Modelerویرایشگر نود و پروسس زیرساختی از جریان کار 

ایجاد  نود که جریان داخلی داده را درون شبکه تشریح میکند بکار برده میشود. ویرایشگر پروسس که جهت 

 تشریح رفتار منطقی مدل و همچنین نود بکار برده میشود  

 ندازیم به گره که سرور را در طبقه اول کنترل میکندحالا اجازه بدهید نگاهی بی

 دابل کلیک کنید  Object Editorبروی سرور در 

 

Node Editor در یک پنجره جدید نمایان میشود 
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 Packetاین شکل نمایانگر مدل گره با ماژول شبکه می باشد . این نو از چندین ماژول درست شده . 

Stream  وStatistic Wires اژولها را به هم متصل کرده است .این م 

  

 

 مدل گره سرور

ها از ماشین کلاینت ارسال شده و به هاب میرسند .و از پشته پروتکل ها  Packetدر حین شبیه سازی ، 

ها مجددا از پشته پایین  Packetپردازش شده تا به ماژول برنامه کاربردی می رسند . پس از پردازش ، 

 فرستاده میشوند تا به هاب رسیده و سپس به ماشین کلاینت بازگردند . 

 

Packet پردازش شده توسط مدل گره 
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را نمایش میدهد . برای دیدن این مدل پراسس   tpalحالا نگاهی بیندازیم به مدل پراسس که رفتار ماژول 

 دابل کلیک کنید tpalبروی 

 

 

 در پنجره جدید نمایش داده میشودمدل پراسس 

 

 

 نمایی از پراسس مدل

به ایستگاههای قرمز و سبز دقت کنید و همچنین به خطوط پیوسته و نقطه چین که نمایانگر انتقال  .1

 بین ایستگاهها و وضعیتها هستند

هستند .  exit executiveو یک  enter executiveهر وضعیت در مدل پراسس شامل یک  .2

اولی زمانیکه اجرا می شود که یک پروسه به یک وضعیت برسد . و دومی زمانی اجرا میشود که 

  پروسه به از یک وضعیت خارج شود .این وضعیتها توسط زبان سی گسترش داده شده اند

 باز کنید initرا با دابل کلیک بروی نیمه بالایی وضعیت  enter execیک   .3



23 
 

 وضعیت باز کنید پایینیدابل کلیک بروی نیمه را با  exit execیک   .4

 

 

 از یک وضعیتExit Exec یا  Enter Exec باز کردن  

 

 

 هر دو پنجره اجرا ببندبد .5

 جمع آوری داده ها

 انجام می گیرد Global Statisticو   Object statisticجمع آوری داده ها به دو طریق 

 چه اطلاعاتی را باید جمع آوری کنیدحال که شبکه ایجاد شد باید تصمیم بگیرید که 

 آیا سرور قادر است تا لود شبکه دوم را نیز هندل کند 

 ( آیا جمع تاخیرEthernet Delay در شبکه قابل پذیرش است پس از آنکه شبکه دوم نیز راه )

 اندازی گردید
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بایستی اطلاعات  فعلی شبکه را بسنجید . برای این منظور Performanceبرای پاسخ به این سوالها باید 

 آماری شیء را محاسبه نمائید

1. Server Load 

 Ethernet Delayیعنی  Global Statisticو یک  .2

بدین منظور   . تمام شبکه است Performanceمیزان لود سرور یک اطلاعات کلیدی است که بازتاب 

 روال زیر را انجام می دهیم

را از منو انتخاب  Choose Individual DES Statisticsکرده و  Right Clickبروی سرور  .1

 میکنیم

 پنجره نمایش نتیجه باز میشود .2

 Ethernetبرای جمع آوری بار ترافیکی  .3

 را باز کنید  Ethernetساختار درختی  .4

 

 

 را انتخاب نمائید  Load (bits/sec)گزینه  .1
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 رافشرده تا دیالوگ بسته شود  OKگزینه  .2

Global statistics    را میتوان برای گرد آوری اطلاعات در مورد کل شبکه بکار برد . برای مثال شما

 میتوانید تاخیر را برای تمام شبکه محاسبه نمائید . برای این منظور 

 را انتخاب نمائید  Choose Individual DESکرده و   Right clickبروی محیط کار  .1

 

 

 را باز کنید Global Statisticsساختار درختی  .2

 را باز کنید Ethernetساختار درختی  .3

4. Delay (sec) را انتخاب نمائید 

3. OK را فشرده تا این پنجره بسته شود 

 حال اولین شبیه سازی را انجام خواهیم داد

مقدار   Network Simulation Repositoriesدر ابتدا شما می بایست چک کنید که آیا 

appropriately را دارد ؟ 
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 منظوربدین 

 را انتخاب کنید .Edit > Preferencesبه منوی  .1

را  Searchرا وارد کرده و دکمه   network simulationعبارت  Search forدر قسمت  .2

 بفشارید

 نبود بروی آن کلیلک کنید stmodاگر مقدار این کلید  .3

 را در فیلد وارد کنید stmodرا فشرده و کلمه  insertدر پنجره جدبد کلید  .4

 را دو بار فشرده تا پنجره ها بسته شوند okدکمه  .3

 برای اجرای سیمولیشن 

 بروید ...DES > Configure/Run Discrete Event Simulationبه مسیر  .1

 شما همپنین میتوانید از این دکمه استفاده کنید .2

 

 
 را بزنید Detailedدکمه  .3

 

 

 وارد کنید Duarationرا در قسمت  3/1مقدار  .4

 وارد کنید Update intervalرویداد را در قسمت  11111مقدار  .3

 تغییر دهید Optimizedرا به    Simulation Kernelمقدار  .5

 را انتخاب کنید  Runدکمه  .1
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 مشاهده نتایج 

 برای مشاهده نتیجه از روش زیر میتوان استفاده کرد

 را انتخاب می نمائیم view resultsکرده و گزینه   Right Clickبروی نود مورد  .1

 را باز نمائید Office network.node_31 > Ethernetساختار درختی  .2

 کلیلک کرده تا انتخاب شود Load (bits/sec)بروی چک باکس  .3

 را جهت نمایش فشار دهید . Show دکمه  .4

 نتیجه مطابق با شکل زیر نمایش داده خواهد شد
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است . شما جهت مقایسه گراف در  bits/second 1،111همینطور که می بینید در این لحظه بار سرور 

 آینده به این گراف احتیاج خواهید داشت .

 بروی شبکه مطابق روال زیر اقدام فرمائید  Global Ethernet Delayبرای مشاهده 

 کنید  Right clikبروی محیط کاری  .1

بروید و چک باکس آن را انتخاب  .Global Statistics > Ethernet > Delay (sec)به مسیر  .2

 نمائید

 < Object Statistics > Office Network.node_31 > Ethernetبه مسیر  .3

Load (bits/sec)  رفته و چک باکس این گزینه را انتخاب نمائید و سپس دکمهShow  را جهت

 دهیدفشار مشاهده تاخیر شبکه برای تمام شبکه 

 مطابق با شکل زیر گزارش را مشاهده خواهید نمود .4
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 نمایش داده خواهد شد .مطابق شکل زیر   Project Editorگراف تاخیر شبکه در 
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 گسترش شبکه

 شبکه فعلی ایجاد و پیاده سازی شد . حالا می بایست شبکه فعلی گسترش بیابد 

 نمائیددو برابر کردن شبکه مطابق روال زیر اقدام برای 

 را انتخاب نمائید Scenarios > Duplicate Scenarioمنوی  .1

 یک نام را جهت نام سناریو جدید انتخاب نمائید .2

 را بزنید Okدکمه  .3

سناریو با تمام نودها ، لینکها ، اطلاعات و آمار و تنظیمات شبیه سازی دوباره ایجاد و با نام جدید  .4

 ایجاد خواهد شد .

 دوباره سازی میکند . اما سروری در آن وجود نخواهد داشت . بخش طبقه دوم طبقه اول را .3

 برای ایجاد بخش جدید مطابق رویه زیر اقدام کنید

 Topology > Rapid Configurationمنوی   .1

 مطابق با تعریف در شبکه قبلی اقدام نمائید .2

 

 

 را بزنید OKدکمه  .3

 برای اتصال دو شبکه 

 زیر را بزنیددر صورتی که پالت اشیا باز نیست دکه  .1
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 را باز کنید the Cisco 2314پوشه  .2

 

 

 Rightرا بوی صفحه کار بکشید و بین دو شبکه قرار دهید . دکه  Cisco 2314شی ء  .3

click را بزنید 

 دابل کلیک کنید 11BaseTماژول مدل لینک را باز کرده و بروی  .4

 کنید  Right Clickروتر را بین دو سوئیچ متصل کرده و  .3

 کنید  Saveپروژه را  .5

 پروژه نهایی شبیه شکل زیر خواهد شد .1
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 برای اجرای سناریو

 را انتخاب کنید ...DES > Configure/Run Discrete Event Simulationمنوی  .1

 ساعت بگذارید 1.3را  Durationرا فشرده و مقدار  Detailدر صورت فعال بودن دکمه  .2

 بگذارید 11111را  Update intervalمقدار  .3

 را بفشارید  Runدکمه  .4

 

 

 کادر محاوره ای فرایند پیشرفت شبیه سازی

در ابتدا ، مانند قبل یک پنجره پیغام آغاز شبیه سازی را نمایش می دهد و سپس یک گراف 

متحرک هردو گراف میانگین و نمودار فعلی را در مقیاس رویداد در ثانیه نمایش می دهد و 

نتیجه )رویداد بر ثانیه  ( نمایان خواهد شدزمانیکه شبیه سازی پایان یافت گراف   

 زمانیکه شبیه سازی پایان یافت ، کادر محاوره ای شبیه سازی را ببندید 

 مقایسه نتیجه:

موجود ، شما نیاز به مقایسه ی  LANدر پاسخ به سوالهای مطرح شده در مورد دومین شبکه اضافه شده به 

 نتیجه از دو شبیه سازی هستید .
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انتخاب کنید   Workspace pop-upو  Object از آیتم منوی View Resultsگزینه  شما می بایست 

 هم  گراف بدانید . تا تفاوت در ترکیب آمار را از سناریوهای شبه به

 برای دیدن سریع لود شدن سرور ازهر دو سناریو: 

را  View Resultsگزینه ی  pop-up راست کلیک کرده و از منوی node_31بر روی سرور  .1

 انتخاب کنید.

 را از منوی پایین انتخاب کنید. Current Projectبرای نتیجه گزینه ی  .2

 هر دو کادر کنار لیست سناریو را کنترل کنید. .3

 را از منوی کشویی برای نمایش انتخاب کنید Overlaid Statistics گزینه  .4

یک سناریو گراف تولید شده ، مقدار اطلاعات تمام زمانیکه مقایسه نتایج انجام میشود ، انتخاب یک آمار در 

 سناریو را نمایش می دهد . برای مشاهده نتیجه

را انتخاب و دکمه  Office Network.node_31 > Ethernet > Load (bits/sec)مقدار  .1

Show . را بزنید . نتیجه درخواستی شما شکل زیر را نمایش خواهد داد 

 مقایسه بار شبکه
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 گراف بعد نمایش دهنده میانگین زمان بار ترافیکی بین دو طبقه است .  

 مقایسه میانگین زمانی بار ترافیکی سرور

 

نکته مهم اینکه ، زمانیکه میانگین بار شبکه جدید بیشتر باشد ، تمام بار نمایش داده شده در حالت شبیه 

  است سازی شده است و نمایانگر اینست که شبکه پایدار

Note that while the average load for the expansion scenario is higher (as 

expected), the load as a whole appears to be leveling off (that is, not 

monotonically increasing), indicating a stable network.  

 Ethernetه است . برای مقایسه تاخیر مرحله آخر نمایش تاخیری که شبکه طبقه دوم به شبکه ما افزود

 باری دو سناری روال زیر را انجام دهید 

 گراف و پنجره نتیجه گزارش سرور را ببندید .1

 را انتخاب کنید View Resultsکرده و گزینه   right clickبروی محیط کار  .2

 را انتخاب کنید .Global Statistics -> Ethernet -> Delay (sec)گزینه  .3

 را بزنید Showدکمه  .4

 نتیجه گراف شما شبیه شکل زیر خواهد بود . .3
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 Ethernetمقایسه تاخیر 

 

 

 SDH در MAC مروری برپروتکل های

دسترسی به رسانه ارتباطی را بوسیله تعریف   MACدر پائین بخش لایه پیوند داده است.لایه   MACلایه 

چندین کاربرامکان را می دهد را هماهنگ می  یک مجموعه قوانین که اشتراک موثر و منصف منابع رایج بین

 کند.

،یک پروتکل کنترل دسترسی به رسانه مطمئن و موثر موردنیاز  NG-SDH بمنظور اجتناب از تصادم در 

 سرعت و  mobilityرا بعنوان نودهای شبکه دارد و خصوصیات اصلی شان  SDH ،vehicleاست. 

به تنظیم ارتباطات مورداعتماد با حداقل تصادم  SDH برای  Active Safetyکاربردی های برنامه. بالاست

ها طراحی شده اند که می توانند بصورت  NG-SDHبرای   MACنیاز دارد. تعداد کمی از پروتکلهای 

 تطبیق داده شود. SDH در کار  موثر برای

، نودها خودشان را پیکر بندی کرده و بدون بکارگیری زیر بنای ثابتی یا مدیریت متمرکزی NG-SDHدر 

نامیده می شوند را به کار  "کانالهای انتقال"، فرکانسهای رادیویی که NG-SDHمحاوره می کنند. نودهای 

صورت همزمان انتقال ن هر کدام به عنوان یک رسانه روی دو ترمینال مجاور که نمی توانند بآمی برند که در 
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به وسیله جامعه تحقیقاتی   MACدهند چون تصادم رخ می دهد. بمنظور اشتراک موثر رسانه ، پرتکلهای 

بالای نودها و تغییرات سریع mobilityبخاطر SDHپیشنهاد شده اند. اشتراک کارا رسانه حتی در 

 توپولوژی سخت تر شده است.

  SDH  شبکهMulti hop  یاست، پروتکلهاMAC درSDH می باید دسترسی به کانال را بین این نودها

به منظور بهره وری دسترسی به رسانه به قدر کافی ، هماهنگ کند. بخاطر به اشتراک گذاشتن دسترسی به 

می شود که سیگنالهای تصادف و  سبب خاص رنج یک در بیشتر  رسانه انتقالهای همزمان بوسیله دو نود با

و حرکت نودهای سیار بر طول سیگنال در terrainیا با یکدیگر روبرو می شوند. در حالتهای دیگر وضعیت 

دسترس دریافت کننده اثر می گذارد. بیشتر نودهای پنهان به انتقال دوباره و رزرو پاکتها منجر خواهد شد. 

 ال جریان روبرو خواهند شد و تصادم روی می دهد.با دیگر انتقالهای در ح آنهابنابراین 

 multi hopانتخاب یک رنج انتقال رادیویی بهینه یک موازنه بین ماکزیمم بهره وری کانال انتقال و

forwarding   است. بنابراین به اجتماع کارایی در ADHOC .تأثیر می گذارد 

و سرعت حرکت بستگی  آنهابه هر حال رنج انتقال مؤثر به تعداد نودها در یک منطقه مشخص و موقعیت 

 منطبق شوند.  SDHدارد. کانالهای بی سیم زمان متغیر و وابسته به موقعیت هستند. نرخ انتقال داده باید با 

مناسب  Vehicularبرای سناریوهای  TDMA ،FDMA ،CDMAتجاری مثل  MACپروتکلهای

از لحاظ تئوری برای  MACA ،MACAW  ، FAMA مثل  ،RTS/CTS  نیستند. شماتیک 

Broadcast  لایه در. اند نامناسبMAC بهترین چیز سازماندهی دسترسی به رسانه یا کنترل ازدحام ،

 یک R-WDMاست. در طریقه معمول اسلات زمانی و طیف می تواند رزرو شود. برای مثال

 مشهور است.MAC،Slot Reservationپروتکل

پروتکل توکن رینگ بی سیم یک پروتکل کنترل دسترسی به رسانه برای شبکه های بی سیم 

محدود شده و پهنای باند رزرو شده که در latencyکیفیت سرویس را به معنی WTRP. (WTRP)است

احتمال انتقال مناسب در  بسیاری از برنامه های کاربردی بلادرنگ بحرانی هستند را ضمانت می کند.

 برای همه پیامها برای کاهش احتمال تصادم بسته شناسایی شده است.MACلایه
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نامیده می شود در ان ADHOCMACکهTDMAبرخی کاندیداهای اصلی این پروتکل مثل رویکرد 

. هر رسانه به فریمهای تکراری تقسیم شده و هر فریم خودش به اسلایدهای زمانی مختلف تقسیم شده است

 نامیده می شود، برسد.(BCH)نود باید یک اسلاید را برای انتقال که کانال اساسی

است. این یک پروتکل Directional Antennaبر مبتنی رسانه به دسترسی کنترل یک همچنین 

CSMA/CA مبتنی برD-MAC.است 

 تصادم از اجتناب برای  ، یک کانال انتقال یک رسانه اشتراک گذاشته شده است و بدین منظور،SDHدر

قتی یک نود در حال انتقال روی یک کانال به نودهای مجاورش است قبل از انتقال باید منتظر و انتقال های

ساختار ثابتی ندارد برای نودهایش دانستن اینکه رسانه ازاد است یا نه SDHباشد تا کانال ازاد شود. و چون 

های موجود مختلف Macساده نیست. کارهای زیادی انجام شده و بسیاری برای غلبه بر مسائل 

 .است جریان SDHدر

WDM اولین پروتکل پیشنهاد شده برای شبکه های رادیویی بسته ای بود. پروسه ،WDM مبتنی بر

ادفی است وقتی یک نود می خواهد یک کانال را بکار برد اول روی ان انتقال می دهد و سپس دسترسی تص

اگر تصادم رخ داد برای یک زمان تصادفی قبل از انتقال دوباره منتظر می ماند. حداکثر کارایی این پروتکل 

. شود می کارایی کاهش سبب  WDM% ظرفیت کانال برای طول پیام ثابت است. دسترسی تصادفی4/13

 اسلات چندین به را رسانه پروتکل این. شد پیشنهاد شود، می نامیده  S-WDMکهSlotted ورژن بنابراین

 ی کند که در شروع اسلات زمانی انتقال را انجام دهدم تلاش کننده ارسال و کند می تقسیم زمانی

 WDM  در مقایسه باS-WDM.دیگر پروتکلی که معرفی شده  ، کارایی سیستم را دو برابر خواهد کرد

یک نود که قصد ارسال داده دارد اول به کانال گوش می دهد اگر CSMAدر. بود  Carrier Senseبود

،  Collision Detection خالی بود ارسال می کند در غیر این صورت یک زمان تصادفی تلاش می کند. 

ارسال را متوقف می کند و بعداً تلاش می که بعداً برای تشخیص تصادم در طول ارسال اضافه شد، 

هنوز در شبکه های شارژ شده وقتی تعداد زیادی تصادم می تواند انجام گیرد، بهینه CSMA/CDکند.

 این است که مسأله ترمینال های مخفی را حل نمی کند.CSMA/CDنیست ضعف اصلی

با توافق روی انتقال با مقصد غلبه به مسئله ترمینال مخفی (MACA)تصادم از اجتناب با چندگانه دسترسی 

را مقداردهی می کند. بنابراین همه نودهای RTS ،Handshakeکرده است. فرستنده با ارسال همگانی بسته 



38 
 

 همگانی ارسال با باشد اماده اگر مقصد  ،RTSمجاور از شروع انتقال اگاه می باشد. بعد از دریافت بسته 

جاورها درباره شروع انتقال اطلاع می دهد. با دریفات بسته پاسخ می دهد که به همه مCTS بسته یک

CTS،  ارسال به شروع تواند می فرستنده Unicast.بدون هیچ ریسک تصادم بپردازد 

را دریافت نکند می تواند انتقال دهد. به علت مسئله ترمینال CTSرا دریافت کند اما ان RTSاگر یک نود 

افزودن MACAWبی حفاظ برای امکان به اینکه ترمینالهای بی حفاظ درباره طول زمان انتقال اگاه شوند 

شامل بسته MACAWتبادل بسته در  1را پیشنهاد داد. شکل DS(Data Sending)و ACKبسته های 

در دسترس    orthogonal کد چندین  CDMAمی کند. پروتکلهای در  های داده و کنترلی را خلاصه

 بکار می برد. آنهاهستند. هر نود یک کد را رمزگذاری پیام ها قبل از انتقال 

WDM  

WDM  بی های شبکه در مشترک کانال به تصادفی دسترسی های روش ترین اساسی از یکی 

می باشد. این روش بر اساس ارسال بسته ها توسط پایانه های بی (MobileDataNetwork)      سیم

سیم بدون نیاز به هماهنگی با دیگر پایانه ها می باشد.مزیت استفاده از این پروتکل سادگی ان و سهولت 

بکارگیری ان است بطوریکه هیچ گونه همزمانی بین فرستنده های بی سیم مورد نیاز نمی باشد. پایانه ها بسته 

را مجددا  آنهاخود را به محض دریافت از لایه بالاتر ، ارسال می کنند و در صورت تصادم بسته ها، های 

ارسال می نمایند. تصادم بسته ها در طرف گیرنده با روش ساده کد بررسی خطا اشکار می شود. بارزترین 

ا با افزایش ه تصادم دتعدا زیرا باشد می شبکه سنگین ترافیک هنگام به  عیب این روش ، گذردهی پایین

 کاربران شروع به افزایش می کند

 پیاده سازی شبیه سازی

 شبکه مدل از پروتکل این سازی پیاده در که پردازیم می CSMAدر اینجا ما به بررسی پروتکل معروف 

د نو مدل یک و کند می ارسال را ها بسته که فرستنده نود مدل یک ما، شبکه مدل هر. کنبم می استفاده مشابه

دربافت کننده را شامل می شوند. مدل پروسس در فرستنده خاص خواهد بود در صورتی که در مدل 

 و تغییر نخواهد کرد. پروسس دریافت کننده عمومی خواهد بود

در طراحی این مدل ها ، نودها با هم از طریق یک شبکه غیر متصل به هم متصل می شوند و با استفاده از 

نرا مجددا ارسال آر گره را تعریف میکنیم برای مثال فرستنده باید هنگام تصادم بسته ماژول پروسس رفتار ه
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کند. مدل شبکه مورد نظر در برگیرنده مدلی از گره های فرستنده و مدلی از گره گیرنده می باشد و هر گره 

 دارای مدل پروسسی است که رفتار گره را تبیین می کند.

ن ها به صورت مجزا داشته باشیم. آاهی به مدل گره ها و پروسس های پیش از طراحی شبکه بهتر است نگ

 این کند می روانه گذرگاه به آنها، شمارش با و کرده تولید را هایی بسته اساسا WDMگره فرستنده در 

پرازشگر پیاده سازی نمود بنابراین  یک و ساده منبع یک از استفاده با گره ماژول در توان می را ساده عملکرد

با استفاده از ماژول گره یک منبع دیتا و یک گره فرستنده ایجاد می کنیم حال تنها نیاز داریم که پردازشگر، 

را شمارش کند نحوه عمل پردازشگر را به هنگام طراحی مدل  آنهابسته ها را به فرستنده تحویل داده و 

 پروسس خواهیم دید.

اساسا تصادم بسته ها را بر روی گذرگاه چک و بررسی می کند و شامل یک گیرنده گذرگاه و  گره گیرنده

ن در این آیک پردازشگر می باشد رفتار پردازشگر توسط مدل پروسس گیرنده تبیین می شود و مسئولیت 

غییر بر روی ماری از طریق ایجاد و تآوری اطلاعات آزمایش اداره کردن بسته های دریافتی به منظور جمع آ

متغیرهای عمومی است . اصولا می توان گفت که این گره تعداد بسته های سالم دریافتی را شمارش کرده و 

 خود بسته ها را دور می ریزد زیرا در حال حاضر محتویات بسته ها اهمیت ندارند.

 فرستنده پروسس مدل طراحی        ·

 در اینجا مدل پروسس فرستنده را ایجاد میکنیم.

 

 مدل پروسس فرستنده

 انتخاب نمائید.File منوی از  را  New>Process گزینه .1
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را به ترتیب به  آنهاسه حالت برای فرستنده ایجاد کرده ،  create state دکمه از استفاده با .2

) tx_pkt)یعنی فرستنده منتظر یک وقفه برا ی ارسال بسته می باشد( و  idleو initنامهای 

 حال ارسال بسته ها می باشد( نامگذاری می کنیم.یعنی فرستنده در 

را ارسال کرده و سپس به حالت ان بالاتر لایه از جدید بسته یک دریافت هنگام به فرستنده .3

Idle برگشته و به انتظار می نشیند بنابر این حالتTx_pkt از نوعForced و حالت

Idle  ازنوع Unforced کلیک بر روی حالت می باشد.برای این منظور از منوی راست

Transmit گزینهMake State Forced.را انتخاب می کنیم 

 گذر که باشید داشته بخاطر. کنیم می رسم دکمه بوسیله  دیگر را حالت به حالت یک از انتقال .4

زمانی روی می دهد که یک بسته جدید از لایه بالاتر وارد Tx_pktبه حالت Idle حالت از

گردد. از این رو یک انتقال شرطی است و بر روی خط گذر راست کلیک کرده وبرای پارامتر 

تایپ میکنیم. همچنین یک خط انتقال اما بدون شرط از Pkt-Arvlتوصیفی شرط عبارت 

 رسم می نماییم.Idle حالت به tx_pktحالت

مدل پروسس دارای هدری است که در کادر هدر میتوان با برنامه نویسی شرایط گذر را و  .3

را تعریف نموده و نحوه جریان بسته ها از منبع دیتا به (Global)همچنین متغیرهای غیرمحلی 

ن آجریان خروجی از فرستنده را نمایش داد. کادر هدر را باز نموده و کد دستورات زیر را در 

 یم:وارد میکن

 ، کد زیر را وارد می کنیمHeader Blockدر  

/* Input stream from generator module */ 

#define IN_STRM 1 

/* Output stream to bus transmitter module */ 

#define OUT_STRM 1 

/* Conditional macros */ 

#define PKT_ARVL (op_intrpt_type() == OPC_INTRPT_STRM) 

/* Global Variable */ 
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extern int subm_pkts; 

 های بسته تعداد حداکثر برای گردد متوقف ای نقطه در ساز شبیه خواهیم می که نجاییآ از .5

در تب متغیر حالت تعریف می کنیم. مقدار  max_packet_count صحیح متغیر یک ارسالی

  تعیین خواهیم کرد.ن را هنگامی که که پارامترهای شبیه سازی را مشخص می نماییم آ

 :کنیم می وارد را زیر اطلاعات  State Variable Blockدر

 

 
)با دوبار  وارد می کنیم Executive Block در  initحالت ،برای کد بصورت را عملیات .1

 (:Stateکلیک بر روی 

/* Get the maximum packet count, */ 

/* set at simulation run-time */ 

op_ima_sim_attr_get_int32 ("max packet count",&max_packet_count); 

 .کنیم می ذخیره را تغییرات .3

 وارد می کنیم:Executive Block،در  Tx_poktحالت برای کد، صورت به را عملیات .8

/* Outgoing packet */ 

Packet *out_pkt; 

/* A packet has arrived for transmission. Acquire */ 

/* the packet from the input stream, send the packet */ 

/* and update the global submitted packet counter. */ 

out_pkt = op_pk_get (IN_STRM); 

op_pk_send (out_pkt, OUT_STRM); 

++subm_pkts; 
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/* Compare the total number of packets submitted with */ 

/* the maximum set for this simulation run. If equal */ 

/* end the simulation run. */ 

if (subm_pkts == max_packet_count) 

{ 

op_sim_end ("max packet count reached.", "", "", ""); 

} 

 .کنیم می ذخیره را تغییرات  .11

را ارسال می کند و همچنین  آنهابسته ها را از جریان ورودی دریافت کرده و  Tx_pkt حالت 

ن که این شمارنده به مقدار آمتغیر شماره بسته های ارسالی را بروز کرده و در صورت 

max_packet_count  برسد عملیات شبیه سازی را به پایان می رساند بنابراین در کادر

  متغیریک  subm_pkts: متغیر  اجرایی ورود به این حالت دستورات زیر را وارد میکنیم

global .است که در پروسس گیرنده تعریف خواهد شد 

در این مرحله برای ان که شبیه ساز بداند چه زمانی کار خود را به اتمام برساند لازم است  .11

نسبت دهیم برای این منظور باید یک پارامتر  max_packet_count  مقداری را به متغیر 

هنگام راه اندازی شبیه ساز مقدار دهی نماییم  ن را بهآتعریف کرده و  (Attribute)توصیفی 

 برای. گردد بارگذاری  max_packet_countای که مقدار این پارامتر به متغیر حالت  به گونه

را انتخاب کرده Process Interfacesماژول پروسس گزینه  Interface منوی از منظور این

 تعریف می نماییم.را از نوع عدد صحیح "max packt count"و دران عبارت 

 

ماژول پروسس را کمی ویرایش نماییم به این ترتیب (Interface) رابط که است لازم پایان در .12

انتخاب کرده و پارامتر توصیفی  Interface را از منوی ProcessInterfaceکه گزینه 
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begsim_intrpt را فعال(enable)  شکل به را پارامترها تمام وضعیت و کرده hidden 

 تعریف می نماییم.

 و نموده کلیک  پس از مراحل بالا باید مدل پروسس را کامپایل کنیم برای این منظور برروی دگمه

 ذخیره می کنیم. WDM_tx عنوان تحت را پروسس مدل نآ از پس

  فرستنده گره مدل طراحی  ·

 کنید.را کلیک Ok دکمه و کرده  انتخاب را  New>Node Model  گزینه File از منوی .1

را به ترتیب  آنهایک فرستنده ایجاد کرده و نام و  (processor) دو مدل پردازشگر .2

"gen" و"tx_proc" و نام فرستنده را"radio_tx".می گذاریم 

را به فرستنده به وسیله جریان بسته ها  tx_procو مدل  tx_procرا به  gen مدل .3

packet streams  کنیم می متصل یکدیگر به. 

ن آو از  simple_sourceرا به صورت پیش فرض  genفی مدل پروسس توصی پارامتر .4

 WDM_txرا به مدل پروسسی که در قسمت بالا طراحی گردید یعنی  tx_procمدل 

 نسبت می دهیم.

 packet" شده وارد های بسته بین زمانی فاصله که است مطلوب فرستنده مدل در .3

Interarrivel Time" از سویgen  زمایش نمائیم برای این آرا با مقادیر مختلقی تنظیم و

 بر  منظور می توانیم مقدار دهی این پارامتر را در سطح بالاتری انجام دهیم از این روی

 promote to higher"راست کلیک کرده و گزینه  gen مدل در پارامتر این روی

layer".را انتخاب میکنیم 

ن جا که این مدل نود را برای مدل آکافی است از  WDM برای مرحله این تا که این با .5

 ن را را کامل تر طراحی می کنیم:آنیز به کار می بریم  CSMAپروسس 

 اضافه می نماییم.  radio_rxو sink جدید با نام هایprocessor ماژول دو منظور بدین .1

 ن ها را بصورت زیر به هم متصل می کنیم:آ
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 می برقرار اتصال ،  Radio_txو tx_procبین    Create Statistic wire بکارگیری با .3

 Falling Edgeو disable   را  rising Edge Triggerن، آ attribute  در. کنیم

Trigger  را  disable  می نماییم همچنین اتصالات را به منظور اینکه به درستی متصل

 اصلاح می کنیم: شده باشند، بررسی می کنیم و در صورت مشکل ان ها را

 src Stream[1]به  Src Stream از  genو Tx_procارتباط 

 Instat[1]به  dest statاز  radio_rx  ،tx_proc  ارتباط

8. interfaces>Node Interfaces و  را انتخاب کنید Node Type 

تغییر دهید به جز  hiddenها را به  Statusهمه. کنید انتخاب   Mobileرا

"gen..packet Interarrivel Time که Permoted  .باشد 
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 ذخیره می کنیم.cct_txدر پایان مدل گره فرستنده تحت عنوان  .11

  گیرنده پروسس مدل طراحی  ·

کلیک Ok دکمه روی بر و انتخاب را  New>Process Modelگزینه File منوی از .1

 میکنیم.

را initنامگذاری می کنیم. حالت "idle"و "init" به را ها ان  ایجاد کرده وstateدو حالت  .2

 از منوی راست کلیک تغییر می دهیم.make state forcedبا انتخاب گزینه 

برای رسم خطوط گذر از یک حالت به حالت دیگر باید عملکرد هر حالت و شرایط گذر را  .3

درک نماییم. اساسی ترین عمل گیرنده این است که در انتظار رسیدن بسته باشد و با رسیدن 

ماری مربوطه را بروز نماید. این رفتار به خوبی در شکل مدل پروسس ذیل آسته مشخصه ب

 مقدار یک و رفته  initدیده میشود. هنگامی که شبیه سازی اجرا می شود گیرنده به حالت 

(. با ورود یک max_packet_cout=1 مانند) دهد می سازی شبیه پارامترهای تمام به اولیه

منتقل  idle حالت به و کرده اجرا را  ()proc_pkt( پروسس ، تابع pkt_rcvdبسته ) شرط 

 واحد یک را بسته شمارنده و کرده دریافت را بسته واقع در  ()proc_pktمیشود. تابع 

 آنجا در شد وارد  idle حالت به که زمانی گیرنده. میریزد دور را بسته سپس و داده افزایش

 تنها  initبه  idle  ه شبیه سازی می باشد. گذر از حالتخاتم فرمان یا و بسته ورود منتظر

(. در پایان شبیه END_SIM شرط یعنی) برسد پایان به سازی شبیه که افتد می اتفاق زمانی

  .شود می آوری جمع  ()record_statsمارها بوسیله روال آسازی ، تمام 
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خطوط گذر و توابعی که باید condition پارامتر تغییر با را انتقال شرایط فوق شکل مطابق .4

به مقادیری که در شکل دیده می شود ویرایش می executiveاجرا گردند با تغییر پارامتر 

 کنیم.

 رد می کنیم.وا را زیر دستورات پروسس مدل هدر کادر در .5

/* Input stream from radio receiver */ 

#define IN_STRM 1 

/*Conditional macros */ 

#define PKT_RCVD (op_intrpt_type () == OPC_INTRPT_STRM) 

#define END_SIM (op_intrpt_type () == OPC_INTRPT_ENDSIM) 

/* Global variable */ 

int subm_pkts = 1; 

 کنیم می شمارش را معتبر های بسته تعداد  rcvd_pktsدر مدل پروسس گیرنده با استفاده از متغیر حالت 

  تعریف می کنیم. integer را از نوع  rcvd_pktsرا باز کرده و متغیر  statevariables کادر روی این از
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برای  ()record_stats تابع از و بسته دریافت برای  ()proc_pktدر مدل گیرنده از تابع  .6

مار بسته ها استفاده گردیده است بنابر این کد توابع اخیر را باید در کادر آنوشتن 

functionblock :مدل بنویسیم. کادر مذکور را باز کرده و دستورات زیر را وارد می کنیم 

/* This function gets the received packet, destroys */ 

/* it, and logs the incremented received packet total*/ 

static void proc_pkt (void) 

{ 

Packet* in_pkt; 

FIN (proc_pkt()); 

/* Get packet from bus receiver input stream */ 

in_pkt = op_pk_get (IN_STRM); 

/*Destroy the received packet */ 

op_pk_destroy (in_pkt); 

/* Increment the count of received packet */ 

++rcvd_pkts; 

FOUT; 

} 

/* This function writes the end-of-simulation channel */ 

/* traffic and channel throughput statistics to a */ 

/* scalar file */ 

static void record_stats (void) 

{ 
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double cur_time; 

FIN (record_stats()); 

cur_time = op_sim_time(); 

/* Record final statistics */ 

op_stat_scalar_write ("Channel Traffic G", 

(double) subm_pkts / cur_time);Bding the WDM  

3op_stat_scalar_write ("Channel Throughput S", 

(double) rcvd_pkts / cur_time); 

FOUT; 

} 

برابر با تعداد بسته های ارسالی در مدت  channel load همانطور که مشاهده می شود ترافیک کانال 

برابر با تعداد بسته های سالم دریافت شده در  channel throughputشبیه سازی و گذردهی کانال 

 همین فاصله زمانی می باشد.

می ماند. بر  initپس از تعریف متغیرها و توابع مورد نیاز مدل پروسس ، تنها کد اجرایی ورود به حالت 

 :میکنیم وارد را زیر کد سپس و کرده کلیک دوبار  initالایی حالت روی نیمه ب

/* Initialize accumulator */                                                                       

rcvd_pkts = 1; 

مدل گیرنده را ویرایش نمائیم از (interface) رابط باید نیز اینجا در فرستنده پروسس مدل مانند .7

را فعال endsim intrptرا انتخاب کرده و پارامتر Process Interfaceگزینه Interfaceمنوی 

(enable)پارامتر و  نموده status را بهhidden.تغییر می دهیم 

 ذخیره می کنیم. cct_rx ا کامپایل کرده و با نام ر مدل پایان در .8
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  گیرنده گره مدل طراحی     ·

 را کلیک نمایید. Ok را انتخاب کرده و دکمه New>Node Model گزینه  File منوی از .1

می  radio_rxو rx_proc ترتیب به را آنها نام و کرده ایجاده گیرنده مدل یک و  پردازشگر مدل یک .2

 گذاریم.

 متصل بسته جریان  (packet stream) دکمه بوسیله  rx_proc را به پردازشگر radio_rx گیرنده .3

 .کنیم می

   در. کنیم می برقرار اتصال ، Radio_rxوtx_procبین   Create Statistic wire بکارگیری با .4

attribute ن،آrising Edge TriggerوFalling Edge Trigger ،disable .می باشند 

را باز کرده و به پارامتر مدل پردازش ان، مدل  rx_procمدل پردازشگر  Attribute تبادلی کادر .5

 .دهیم می نسبت  cct_rxقسمت قبلی را یعنی 

تغییر می دهیم به این ترتیب که در جدول  Interfaceگره را از منوی  (interface) رابط .6

NodeType  مقدار پارامتر بهno برای نوع mobile  تغییر داده وyes  می کنیم و همچنین

 تغییر می دهیم. hiddenرا به  Status پارامترهای 

 ذخیره می کنیم. cct_rx  عنوان تحت را گره مدل .7

 

 

 بدین کنیم ایجاد را شبکه مدل باید حال رسد می اتمام به WDMدر اینجا طراحی مدل گره و پروسس 

 :کنیم می عمل ترتیب بدین منظور

 



51 
 

 WDMطراحی مدل شبکه 

 را کلیک می کنیم.Okانتخاب کرده و دکمه  را New>Project گزینه  File منوی از .1

 wizardانتخاب کرده و با برنامه  WDM  را نآ سناریو و نامیده  cct_Network_ را پروژه نام .2

 مشخصات شبکه را به شکل زیر تعیین می کنیم.

3. Enterprise > … > NG-SDH  و سپس کلیدOk.را کلیک می کنیم 

را به  cct_rx_و  cct_tx_یتم های آسپس   و Configur Palette>Clear  ابتدا object  پالت در .4

نود موبایل ت ذخیره می کنیم. این ها که به صور cct_ن مدل شبکه را با نام آ پالت اضافه می کنیم و

 اضافه می شوند امکان ایجاد مدل شبکه را فراهم می کنند.

 

 
 Rapid configuration>Unconnectedگزینه  Topologyاز منوی  Project  پنجره در .3

Net  کنیم می پر را تبادلی کادر مقادیر زیر شکل مطابق و کرده انتخاب را. 
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 mobility Configکرده که از پالت  عمل صورت بدین موبایل نودهای برای سرعت تعیین برای حال .5

و  (SDH) تعیین کردهرا  Profile، نام   Random Mobility Fileرا انتخاب کرده ودر قسمت

پارامتر  Radom Waypoint Parameterقرار میدهیم و در Radom Waypointمدل حرکتی را 

Speed کنیم می دهی مقدار  را با سرعتی بالا(خاص خصوصیات SDH در مقابلNG-SDH )

است دامنه ای برای حرکت نود سیار ایجاد می کنیم )نودهای  SDHدرضمن بدلیل اینکه شبکه 

SDHمحدوده خاص حرکت می کنند( برای این منظور درmobilityDomain  و کرده انتخاب را 

انتخاب  mobility Domain Name در را دامنه این نام و کرده محدود خاص های بازه در را نودها

 می کنیم.

 
 

 

 اضافه ان به را گیرنده گره که است لازم و کرده ایجاد فرستنده 11 توپولوژی این با وسیله بدین .1

 .کنیم می اضافه صفحه به  cct_rxگره یک منظور بدین.کنیم

 کنیم . می ذخیره  cct_network_راحل بالا ،مدل را با نام شبکهم اتمام از پس .3

 WDM سازی شبیه اجرای     ·
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 12را در شرایط مختلف ترافیک کانال مورد تحلیل قرار می دهیم. WDMدر این بخش گذردهی پروتکل 

 مختلف همزمان بوسیله ادیتور شبیه ساز انجام می گیرد. پارامتر فاصله زمانی دریافت بستهشبیه سازی 

(inter-arrival time)  توسط فرستنده را طی چندین شبیه سازی تغییر می دهیم تا سطوح مختلفی از

 یم.ترافیک ایجاد گردد و همچنین با تغییر سرعت ها و تعداد نودهای موبایل شبکه را تحلیل می کن

1. Scenario>Scenario Components>Import.را انتخاب کنید 

2. SequenseSimulation   ا از منوانتخاب کرده و رcct_network-CSMA.را انتخاب کنید 

را انتخاب می  Configure Discrete Event Simulation(Advanced)گزینه DES از منو .3

 کنیم.

 انتخاب می کنیم.را Edit Attributes گزینه و کرده کلیک راست .4

 را انتخاب کنید. Advancedکلیک کرده و  Executionروی نود درخت  .3

 انتخاب کنید.cct_networh-WDM_  مدل شبکه را  .5

 کلیک کنید.Statistic Collectionو سپس Outputsروی نود  .1

3. Prob Fileرا به<None> تنظیم کنید.تابعop_stat_Scalar_Writeو فایلScalar جایگزین می

 شود.

 تنظیم کنید.cct_a_را به Scalarفایل  .8

وارد cct_rx_در Function Blockرا که op_stat_Scalar_Writeاین فایل خروجی تابع  

 وری می کند.آکردید ، جمع 

11. Clear Scalar File Before Running Simulation Set.را تیک بزنید 

 تنظیم 1111 به  را maxpacketcountکلیک کرده و مقدار فیلد  Globl Attributesبر روی تب  .11

 .کنیم می

مقدار در  12کلیک کرده و دقت کنید  ObjectAtributes  بر روی  .12

Network.*.gen.PacketInterarrivalTime باشد موجود. 

13. Yes کادر و کرده کلیک را SimulationSet.را ببندید 

14. File>Save.را انتخاب کنید 
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کلیک کرده و عملیات اجرا را تایید می Execute Simulation Sequence  بر روی دکمه نوار ابزار .13

 کنیم.

 را می بندیم.Simulation Sequenceوقتی شبیه سازی تکمیل شد کادر  .15

CSMA 

پشتیبانی شود CarrierSense می تواند وسیله افزودن قابلیت WDMکارایی پروتکل دسترسی تصادفی 

داده برای گوش دادن به کانال و مشخص کلاسیک که نیاز به یک منبع CSMA.این قابلیت در پروتکل 

 را موجود WDM_tx_کردن ازاد بودن کانال بمنظور ارسال داده را دارد. بدین منظور می توان از پروسس

 .برد بکار شود ازاد کانال تا شود منتظر پروسس که این بعنوان

 را انتخاب کنید.WDM_tx_، مدل PrjectEditorدر 

 کنید تا شکل زیر حاصل شود.حالت ها و گذرها را اصلاح 

 

 نام دهید.Wt_freeن را آیک وضعیت جدید ایجاد کرده و  .1

 تغییر دهید.CH_GOES_FREEایجاد کنید و وضعیت را به tx_pkt به wt_freeیک گذر از از  .2

 تنظیم کنید.defaultبه خودش برگردنید و وضعیت را به Wt_freeیک گذر از حالت  .3
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تغییر PKT_ARVL&&FREE به را نآ  conditionایجاد کنید و wt_free به  idleیک گذر از  .4

 دهید.

 تنظیم کنید.defaultبخودش برگردنید و وضعیت را به idleیک گذر از .3

 تغییردهید.PKT_ARVL&&FREE به را  tx_pktبه idleوضعیت گذر از  .5

 تغییر دهید.defaultرا به شرطی با تنظیم وضعیت به tx_pktوضعیت گذرغیر شرطی از  .1

به خودش برگردانید و وضعیت را به tx_pktیک گذر از حالت  .3

PKTS_QUEUED&&FREE.تنظیم کنید 

ایجاد و وضعیت را wt_freeبه tx_pktخر، یک گذر از آدر  .8

PKTS_QUEUED&&FREE.تنظیم کنید 

 Header Blockویرایش 

    Header Blockنه یا است زادآ کانال که کند بررسی ، ازانتقال  را می باید به منظور اینکه پروسس قبل 

 پروسیجر با اول باید ، کند ارسال را بسته پروسس اینکه برای.دهید ،تغییر

.اگر کانال  است زادآ کانال که  کند چک  کانالbusy  مارهایآبا خواندن ()op_stat_local_read  هسته

در یافت "channel goes free"وارد می شود تا اینکه وقفه wt_freeزاد نیست .پروسس به وضعیت آ

 شود.

کردن enable بوسیله و است شده تریگر کند تغییر   1.1 به busyوقتی  statisticwireدر سطح نود ،

 فعال شده است . Fallingedgetriggerگیژ  وی

 مدل پروسس اضافه کنید.Header Blockخطوط زیر را در پایان 

/* input statistic indices */ 

#define CH_BUSY_STAT 1 

/* Conditional macros */ 

#define FREE (op_stat_local_read (CH_BUSY_STAT) == 1.1) 

#define PKTS_QUEUED (!op_strm_empty (IN_STRM)) 
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#define CH_GOES_FREE (op_intrpt_type () ==  

OPC_INTRPT_STAT) 

1. Header Block.را ذخیره کنید 

2. File>Save as را انتخاب کنید و مدل را به_csma_tx.تغییر نام دهید 

 را ببندید.Proccess Editor و کنید کامپایل را مدل .3

 :CSMAبرای پشتیبانی مدل نود ارسال کننده برای پشتیبانی  

1. File > Recent Files > Node Model و کنید انتخاب را _cct_tx.را انتخاب کنید 

 fallingEdgetriggerرا انتخاب کرده و Editراست کلیک کرده و  statisticwire روی .2

 را کلیک کنید.Okکنید و  Enable را 

تغییرداده csma_tx_  را باز کنید و مدل پروسس را بهtx_procبرای ماژول Attributeکادر تبادلی .3

 کادر را ببندید.

ول دریافت ژارسال شده روی ماماری شلوغی کانال آپروسسور اکنون یک مدل پروسس که روی وقفه های 

 کننده عمل می کند را بکار می برد.

4. File>Save as مدل به انرا و کنید انتخاب را _cct_csma_tx تغییر نام دهید وNodeEditor را 

 ببندید
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 تعریف مدل شبکه

اصلاح شد ،نیاز به تغییر مدل شبکه برای استفاده از مدلهای جدید  CSMA حال که مدلها برای پشتیبانی 

کنید و تغییرات دلخواه را duplicateاست. به جای ایجاد یک مدل جدید، می توانید سناریوی جدید را 

 اعمال کنید .

را انتحاب کرده و نام جدید سناریو …Project Editor،Scenario>Duplicate Scenarioدر .1

 کنید. انتحابCSMAرا 

 است.  CSMAد ستفاده از نود انتقال دهنده جدیتنها تغییرمدل شبکه ا

 را به پالت اضافه کرده و پالت را با نام پیش فرض ذحیره کنید.cct_csma_tx_مدل نود  .2

 را انتخاب کنید.Select Similar Nodesروی نودهای فرستنده راست کلیک کرده و  .3

 را از منو انتخاب کنید.EditAttributesروی همه نودهای انتخاب شده کلیک کرده و  .4

3. Apply Change To Selected Objects.را تیک بزنید 

 را کلیک کنید.Okتغییر داده و cct_csma_tx_را به modelخصوصیت  .5

 . یرات نمی تواند نیمه کاره باشدیک کادر تبادلی باز می شود و هشدار می دهد که تغی

1.  Yes.را کلیک کنید 

 تغییر داده می شوند.cct_csma_tx_مدل های نود به 

 CSMAشبیه سازی  پیکربندی

را انتخاب می Configure Discrete Event Simulation(Advanced)گزینه DESاز منو .1

 کنیم.

 را انتخاب کنید.Edit Attributesو Simulation Setروی  .2

3. seed دهید تغییر 11 به را. 

 کلیک کنید.Statistic Collectionو سپس Outputsروی نود  .4

 تنظیم کنید.cct_c_رابهScalarفایل  .3

5. Prob File را به<None>..تنظیم کنید 
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1. Yes  کادر و کرده کلیک را Simulation Set.را ببندید 

3. File>Save.را انتخاب کنید 

اجرا را  کلیک کرده و عملیاتExecute Simulation Sequence   بر روی دکمه نوار ابزار .8

 تایید می کنیم.

 را می بندیم.Simulation Sequenceوقتی شبیه سازی تکمیل شد کادر  .11

 

 SDHدیگردر شبیه سازی MACبررسی پروتکل 

 پروسس مدل طراحی        ·
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 کنیم. کلیک میOk دکمه روی بر و انتخاب را  New>ProcessModelگزینه File منوی از .1

و قرمز Forced نوع از سبز های حالت. کنیم می نامگذاری را آنها  ایجاد کرده وstateده حالت  .2

از منوی راست کلیک تغییر make state forcedهستند که با انتخاب گزینه Unforcedاز نوع 

 می دهیم.

با رسم خطوط گذر از یک حالت به حالت دیگر عملکرد هر حالت و شرایط گذر را ایجاد  .3

 .نماییم  می

خطوط گذر و توابعی که باید اجرا conditionمطابق شکل فوق شرایط انتقال را با تغییر پارامتر  .4

 به مقادیری که در شکل دیده می شود ویرایش می کنیم.executiveگردند با تغییر پارامتر 

 در مدل پروسس دستورات مورد نیاز را وارد می کنیم.TVو DB ،FB ،SV ،HBدر کادر  .3

 و نموده کلیک    باید مدل پروسس را کامپایل کنیم برای این منظور برروی دکمهپس ازمراحل بالا .5

 ذخیره می کنیم.MAC عنوان تحت را پروسس مدل ان از پس

 گره مدل طراحی        ·

 

و "gen"را به ترتیب  آنهاو دو فرستنده ایجاد کرده و نام (Processor) پردازشگر مدل دو .1

"MAC_SDH" و نام فرستنده را"port_rx_1_1"و"port_tx_1_1".می گذاریم 

 packet ها بسته جریان بوسیله  و این مدل را به فرستنده و گیرندهMAC_SDHرا به gen مدل .2

streams  کنیم می متصل یکدیگر به. 

ن مدل آو از simple_sourceرا به صورت پیش فرض gen پروسس مدل توصیفی پارامتر .3

MAC_SDH را به مدل پروسسی که در قسمت بالا طراحی گردید یعنیMAC.نسبت می دهیم 
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 packet Interarrivel" شده وارد های بسته بین زمانی فاصله که است مطلوب فرستنده مدل در .4

Time" از سویgen زمایش نمائیم برای این منظور می توانیم مقدار آرا با مقادیر مختلقی تنظیم و

 مدل در پارامتر این روی بر  در سطح بالاتری انجام دهیم از این روی دهی این پارامتر را

gen راست کلیک کرده و گزینه"promote to higher layer".را انتخاب می کنیم 

و " port_rx_1_1”, MAC_SDHبین Create Statistic wire  بکارگیری با .3

""port_tx_1_1.اتصال برقرار می کنیم ، 

را  Falling EdgeTriggerو disableرا  rising Edge Triggerفرستنده، attribute   در 

enable می نماییم و همچنین در   attribute ،گیرنده rising Edge Trigger و Falling 

Edge Trigger  را disable  می نماییم همچنین اتصالات را به منظور این که درستی متصل شده

 .را اصلاح می کنیم آنهارت مشکل باشند را بررسی می کنیم و در صو

5. interfaces>NodeInterfaces  را انتخاب کنید و NodeType  را Mobile  .انتخاب کنید

که gen..packet Interarrivel Time"تغییر دهید به جز hiddenها را به  Statusهمه 

Permoted  .باشد        

 ذخیره می کنیم.SDHدلخواه مثل  ل گره فرستنده تحت عنوانمد پایان در .1

 نظر مورد پروتکل شبکه مدل طراحی     ·

 را کلیک می کنیم.Okرا انتخاب کرده و دکمه New>Project گزینه  File منوی از .1

انتخاب کرده و با برنامه MAC را نآ سناریو و نامیده  SDH_MAC را پروژه نام .2

wizardمشخصات شبکه را به شکل زیر تعیین می کنیم 

3. Enterprise > … > NG-SDH و سپس کلیدOk.را کلیک می کنیم 

 می اضافه پالت به را  SDHیتمآو سپس  Configur Palette>Clearابتدا object  پالت در .4

ه به صورت نود موبایل اضافه می شوند ک ها ابن.میکنیم ذخیره دلخواه نام با را شبکه مدل وآن کنیم

 امکان ایجاد مدل شبکه را فراهم میکنند.

 Rapidگزینه  Topology از منوی  Project  پنجره در .5

configuration>UnconnectedNet  تبادلی کادر در کرده انتخاب را  Node model را

SDHو تعداد را تعیین و نوع نود راmobile کنیم می انتخاب . 
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 mobilityحال برای تعیین سرعت برای نودهای موبایل بدین صورت عمل کرده که از پالت  .6

Config انتخاب کرده و در قسمتراRandom Mobility File  نام ،Profile را تعیین کرده

(SDH و مدل حرکتی را)Radom Waypoint قرار می دهیم و در   Radom 

WaypointParameter پارامترSpeedخاص خصوصیات)کنیم می دهی مقدار  را با سرعتی بالا 

SDHدر مقابل 

7. NG-SDH درضمن بدلیل اینکه شبکه )SDH است دامنه ای برای حرکت نود سیار ایجاد می

 را  mobility Domainدر محدوده خاص حرکت می کنند( برای این منظورSDHکنیم)نودهای 

 mobility در را دامنه این نام و کرده محدود خاص های بازه در را نودها و کرده انتخاب

DomainName.انتخاب می کنیم 

 ذخیره را مدل بالا، مراحل اتمام از پس. ایم کرده ایجاد  تعدادی نودبدین وسیله با این توپولوژی  .8

 .کنیم می

را انتخاب می Configure Discrete Event Simulation(Advanced)گزینه  DESاز منو .9

 کنیم.

 را انتخاب می کنیم وتغییرات لازم را اعمال می کنیم.Edit Attributes گزینه و کرده کلیک راست .11

11. Yes کادر و کرده کلیک را SimulationSet.را ببندید 

12. File>Save.را انتخاب کنید 

کلیک کرده و عملیات اجرا را تائید ExecuteSimulationSequence بر روی دکمه نوار ابزار .13

 می کنیم.

 را می بندیم.SimulationSequenceوقتی شبیه سازی تکمیل شد کادر  .14
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 Opnet نرم افزار   جزئیات نصب

 است  OPNETاین صفحات شامل آموزش تصویری و قدم به قدم نصب و تنظیم نرم افزار 

بروی دستگاه خود مطمئن شوید . هرچند  Cاز نصب یک کامپایلر  OPNETنکته : قبل از نصب نرم افزار 

  شما میتوانید پس از عملیات نصب نیز کامپایلر را بروی دستگاه خود نصب نمائید .

 سه ماژول زیر می بایست نصب و پیکر بندی گردند OPNETنرم افزار برای استفاده از 

 Opnet Modeler 

 Opnet Model Library 

 Opnet Model Documentation 

 ترتیب نصب دقیقا به بصورت ذکر شده است

 لطفا به دقت هر مرحله را جهت نصب و پیکر بندی انجام دهید

 Opnet Model Libraryنصب  .1
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. این اطلاعات  شامل معرفی مقررات   را انتخاب می نمائیم NEXTدر اولین صفحه گزینه  گام اول :

 نصب می باشد .

 

 انتخاب یک پوشه در سیستم جهت نصب کتابخانه های نرم افزار:  دومگام 
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 Installبررسی خلاصه انتخابهای نصب و در صورت صحت فشردن دکمه  گام سوم :
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 پس از انجام پروسه نصب Doneفشردن کلید  گام چهارم :
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 Opnet Modelerنصب  .2

 را می فشاریم Nextدر صفحه اول کلید گام اول : 
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 در سیستم modelerانتخاب یک مسیر جهت نصب  گام دوم :
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را بدون تغییری   Nextرا انتخاب نکنید . کلید  "Send reports to Report Server"گزینه گام سوم :

 در این صفحه بفشارید
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 Nextرا انتخاب و دکمه  "Floating - access license from remote server"گزینه گام چهارم : 

 را بفشارید
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این اطلاعات به همراه   . را بفشارید  Nextرا وارد کرده و کلید  licenseسرور   Hostnameگام پنجم : 

CD . نصب به شما ارائه میگردد 



71 
 

 

 حتما سه گزینه انواع فایل را انتخاب کنیدگام ششم : 
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خلاصه وضعیت نصب که توسط خود شما تنظیم شده را بررسی و در صورت صحت دکمه گام هفتم : 

Install را بفشارید 
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 را جهت خاتمه عملیات نصب بفشارید . Doneدکمه گام هشتم : 
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 Opnet Modeler Documentation .نصب  

 را جهت شروع عملیات نصب بفشارید Nextکلید  قدم اول :
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 یک پوشه جهت نصب فایلهای کتابخانه نرم افزار را انتخاب نمائید : دومگام 
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خلاصه انتخابهای نصب را مرور کرده و در صورت صحت داده ها نصب را با فشردن دکمه  : سومگام 

Install نمائید . آغاز 
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 ی پروسه نصب بفشاریدآنهارا در  Doneکلید  : چهارمگام 
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 پس از طی تمام این مرحله لایسنس را نیز نصب نمائید .

 گام پنجم :

 نمائید و از صحت آن نیز اطمینان حاصل فرمائید Pathمسیر های زیر را در سیستم 

DevEnvDir = C:\Program Files\Microsoft Visual Studio 11.1\Common1\IDE 

FrameworkDir = C: \ WINDOWS \ Microsoft.NET \ Framework  

INCLUDE =  

C: \ Program Files \ Microsoft Visual Studio 8.1 \ VC \ ATLMFC \ INCLUDE;  

C: \ Program Files \ Microsoft Visual Studio 8.1 \ VC \ INCLUDE;  

C: \ Program Files \ Microsoft SDKs \ Windows \ v5.1A \ include;  

LIB =  
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C: \ Program Files \ Microsoft Visual Studio 8.1 \ VC \ ATLMFC \ LIB;  

C: \ Program Files \ Microsoft Visual Studio 8.1 \ VC \ LIB;  

C: \ Program Files \ Microsoft SDKs \ Windows \ v5.1A \ lib;  

LIBPATH =  

C: \ WINDOWS \ Microsoft.NET \ Framework \ v3.3;  

C: \ WINDOWS \ Microsoft.NET \ Framework \ v2.1.31121;  

C: \ Program Files \ Microsoft Visual Studio 8.1 \ VC \ ATLMFC \ LIB;  

C: \ Program Files \ Microsoft Visual Studio 8.1 \ VC \ LIB;  

PATH =  

C: \ Program Files \ Microsoft Visual Studio 8.1 \ Common1 \ IDE;  

C: \ Program Files \ Microsoft Visual Studio 8.1 \ VC \ BIN;  

C: \ Program Files \ Microsoft Visual Studio 8.1 \ Common1 \ Tools;  

C: \ WINDOWS \ Microsoft.NET \ Framework \ v3.3;  

C: \ WINDOWS \ Microsoft.NET \ Framework \ v2.1.31121;  

C: \ Program Files \ Microsoft Visual Studio 8.1 \ VC \ VCPackages;  

C: \ Program Files \ Microsoft SDKs \ Windows \ v5.1A \ bin;  

VCINSTALLDIR =  

C: \ Program Files \ Microsoft Visual Studio 8.1 \ VC  

VS81COMNTOOLS =  

C: \ Program Files \ Microsoft Visual Studio 8.1 \ Common1 \ Tools \  

VSINSTALLDIR =  

C: \ Program Files \ Microsoft Visual Studio 8.1  

WindowsSdkDir =  
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C: \ Program Files \ Microsoft SDKs \ Windows \ v5.1A \  

 

 Startاکنون میتوانید برنامه را از منوی  و تعریف صحیح مسیرها   سه ماژول فوق در صورت نصب صحیح 

 اجرا نمائید Programsو زیر منوی 

را انتخاب   "I Accept"گزینه  Accept the user agreementدر ابتدای نصب برنامه در قسمت 

 نمائید .
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 آماده بهره برداری است Opnetاکنون شبیه ساز 

 

  


